RAID-1 Bottom Line: RMAing HD2



Posted by Dirk on Tuesday, May 27 at 18:40
After some extended testing, I believe HD2 (S/N 6RA5GRAY) is the problem. It's been acting erratic and inconsistent. It's also being RMAed back to Seagate. 

HD1 is in its own RAID-0 striped array. I know that it takes two drives to have a RAID-0 array, but I put HD1 in its own striped array to see if I would get any errors that were Nvidia oriented to rule out flakey NVRAID possibilities. For the past few days, I haven't received any NVRAID related controller or driver errors. I can't say the same for HD2 when I had it in it's own RAID-0 array. 

HD2 (S/N 6RA5GRAY) Errors/Problems

Computer Management – Event Viewer - System

- CM-EV-Sys- Disk Driver Detected Controller Error OS Disk-1 6RA5GRAY.

- CM-EV-Sys- Disk Driver Detected Paging Error OS Disk-1 6RA5GRAY.

- CM-EV-Sys- NVRAID Driver Detected Controller Error (CE).

- CM-EV-Sys- NVRAIDS CE A/C 1.1 HD2 6RA5GRAY.

- HD2 6RA5G4AY auto set to SATA-1 by OS while in mirror array.

- RAID ACCESS FAILURE (RAF) A/C 1.0 used by HD2 6RA5G4AY.

- RAF A/C 2.1 used by HD2 6RA5G4AY.

- RAF NVMS Shows A/C 1.0 HD2 6RA5G4AY as free disk after dropping out of array.

- RAF with HD2 6RA5G4AY as single disk RAID-0 array.

- HD2 6RA5G4AY SATA Mode detected as OS HD0 on port 2.

- HD2 6RA5G4AY SATA Mode detected as OS HD1 on port 2.

- HD2 6RA5G4AY SATA Mode not detected as OS HD0 on port 2.

- HD2 6RA5G4AY SATA Mode not passing Speed Test.

- HD2 6RA5G4AY SATA Mode passing Speed Test.

System Spec & Drivers

MS Windows XP Pro w/ SP3

SilverStone Strider ST75F Modular 750W PS

ASUS M2N32-SLI DWE AM2 nForce 590


- 9.35_nforce_winxp_international

AMD Athlon 64 X2 5400+ 2.8GHz (Brisbane)


- AMD Dual-Core Optimizer 1.1.3


- AMD Processor Driver Version 1.3.2.0053

Arctic Silver 5 Thermal Compound

ZEROtherm Nirvana NV120 120mm hs/fan combo

OCZ Platinum 2GB DDR2 1066 (PC2 8500) Dual Channel Kit

EVGA 512-P3-N841-A3 GeForce 8800GTS (G92)


- EVGA GeForce 8 series driver 169.44_XP32 3-6-08

2-Seagate Barracuda 7200.10 160GB 7200 RPM 8MB Cache

SAMSUNG 20X SH-S203N SATA DVD R/RW

Sound Blaster X-Fi XtremeGamer Fatal1ty Professional


- Creative Sound Blaster X-Fi series Driver 2.15.0006 3-14-08

- Nvidia drivers are installed in Windows normal environment after AV/AS software is disabled.

- Nvidia drivers are removed in Safe Mode because uninstall program hangs in Windows normal environment.

- CPU temp is generally 38 C via Asus Probe-2 or 48 C via mobo bios, whichever you believe.

- CPU voltage is 1.33V and AMD specs indicate acceptable range of 1.325/1.35/1.375V.

- Do not have Windows Power Management set up for turning off hard drives.

- Have tried both nForce 9.35 & 9.19 drivers.


- MediaShield, nForce PCI System Mgmt drivers, and Ethernet drivers installed.

Errors after implementing NVRAID

- Stop 0x0000000A Irql_Not_Less_or_Equal errors and MS's KB article on how to fix it is pretty useless http://support.microsoft.com/kb/314063.

· Had to disable the "Restart immediately so I can't read BSOD info" option in Device Manager Advanced section to see this and other errors.

· Had the usual gamut of 0x0000000(X) errors that you can find on the web.

· These errors periodically happen during trial and error troubleshooting process based on whatever method used to deduce and fix problems.

- BSOD error saying that the usbport.sys file caused a problem.  


- The Standard OpenHSD and Enhanced PCI to USB Host Controllers use that file as seen in Device Manager> View> Devices by Type> Driver.


- USB mouse and keyboard use the Standard OpenHSD USB Host Controller.



- The Standard OpenHSD USB Host Controller and a Nvidia nForce SATA Controller use the same IRQ.



- Currently, both hard drives in a mirrored array are using that Nvidia nForce SATA Controller.



- See Device Manager> View> Resources by Connection.


- Mobo wireless adapter uses the Enhanced PCI to USB Host Controller.



- The Enhanced PCI to USB Host Controller does not share its IRQ.

- System lockups on booting that required a reset.


- Sometimes the problem is a POST that doesn't complete, i.e hangs, or an OS load that seems to loop.



- HD2 seems to cause some of this looping because it stops when booting without HD2 connected.



- On occasion, the OS is not looping, but it is sorting out things and takes about 5 minutes to bring up the desktop.



- After this 5 minute sorting, the OS will load as normal as it's going to get.



- Event Viewer: Application & System info is reviewed for system problem clues.

- Data Execution Prevention alerts and interventions towards Windows Explorer.  


- I have set DEP to ignore Windows Explorer.  


- In the seven years I ran WXPP on my old Asus A7M266 system, I never had one DEP problem with WE.



- Maybe it's due to new WXPP hot fixes like unsecapp.exe.  Don't know. Mystery.

- One morning during a boot, the system would not POST and shutdown after 3 seconds. Ended up removing all seemingly relevant hardware from the computer in preparation for hard boot.  Only thing left connected to the mobo was the cpu with the hs/fan combo.  When hard booted, system still wouldn't post and shutdown after 3 seconds.  As a last resort, since they were the only power drawing items connected, removed both 80 mm fan connections from the modular ps connections.  Rebooted system, it came back to life, and received beeps indicating no RAM detected.  Very odd.  


- PS does have over voltage and over current protection built-in.  



- Suspect this safeguard was tripped. 


- Plugged everything back in and OS booted to desktop, but raid errors persisted.


- Has not happened again over several weeks of trial and error troubleshooting.

- Had the mobo BIOS completely wiped out and reset out of the blue during a boot up session.


- Has not happened again over several weeks of trial and error troubleshooting.

- HD2 (S/N 6RA5GRAY) would completely drop out of the mirrored array at times and out of DM.  


-That action in itself would make me think it's a hd issue.  


- Need to make HD1 (S/N 9RA49LSH) as the mirrored hd and see what happens to rule out HD2 being defective



- Testing both physically via cable and logically via NVMS bios

- My experiences aren't anything new to ExtremeTech.


- ET - My PC Hell - Loyd Case - 12/05 http://www.extremetech.com/article2/0,2845,1903058,00.asp

- ET -  Preparing for the Crash - Joel Durham Jr. - 4/08 http://www.extremetech.com/article2/0,1558,2284355,00.asp
"Why hadn't I been using RAID in the first place? When I built the new system, I'd gone from an Nvidia 680i chipset to an Intel P35. Nvidia's RAID system seemed to me to be about as stable as house of cards set up in front of jet turbine. Every day—I'm not kidding here, every day—the OS (Vista) reported RAID errors." -  Joel Durham Jr
Tests Ran

- Ran Memtest86+ 2.01 (02/21/2008) and it went through 3 full test runs to show the memory was fine.

- Bumped up memory from 1.8V to 2.0V during effort to get memory to 1066 MHz.

- OCZ's has a 2/2008 FYI sticky on it's forum indicating memory bought from the beginning of the year needs less than full voltage to operate properly.

· OCZ's rule of thumb advice is to use the least amount of memory voltage that allows for a stable system.

· NVRAID oddities were happening long before fsb oc'd, memory voltage upped 0.2V, and changed memory tRC from 19 to 22 per CPUID info and OCZ EPP specs.

- Ran Seagate's Seamonkey Tools DOS 1.1.2.0 over both drives twice and both drives passed the short and long tests each time.

· Apparently, the Defcon 10 Advanced test via the Windows version of Seamonkey Tools is only for SCSI drives and controllers.

· Per Seagate's "We're not responsible for anything." notice, the Advanced Tests can possibly unleash a small supernova on your hard drive and make it useless.

· Only Short & Long generic tests are available in WXPP environment, which makes Seamonkey Tools Windows version pretty much a "why bother?" experience.



- SMART Check doesn't work with SMART enabled on the drive and in the mobo bios.



- Short & Long Drive Tests do not work.



- Drive information inquiry function doesn't work.

- I've run WXPP system file checker /scannow in order to have it check the system files and didn't get an error if one was ever going to be produced.

BIOS

- Flashed  mobo BIOS from original BIOS version 0302 to a more recent BIOS version 1701.


- That means it's an Enterprise class BIOS, right?



- I swear can hear a tiny Scottish engineer in the nvraid controller pulling his hair out and screaming profanities.




- At least I'm not alone in my frustration.

WXPP Install Woes

- Repaired and reinstalled WXPP to the point of reactivating it too many times.


- Apparently having system specs being the same each time doesn't matter.

· Saving a copies of the wpa.bak and wpa.dbl files to paste in the System32 folder to by-pass activation with same system specs didn't work.

· Had to call MS automated system to get a 40 number activation key to input into some fields to reactivate copy of WXPP-SP2.

Ghosting

- Ghosted the 40 number authorized install sans any drivers or updates in case I had to reinstall a clean version of the OS.  

- After installing programs and customizing OS, cleaned it with CCleaner, Norton Windows Doctor, Defrag, etc. and Ghosted this ready-to-go OS for future use.

· Have saved my bacon with this Ghost image at least a dozen times with the need to reimage the C drive partition with this OS.

- Found Nvidia KB for correct way to Ghost and image through a NVRAID array.  


- Assume instructions need to be followed when making "and" applying an image file.

Changes Made

- Changed out the physical SATA cable on the drive that gets errors on A/C 1.1  Didn't make a difference.  Got an A/C 1.1 access error with new cable.  

- Moved SATA cables to 2.0/2.1 from 1.0/1.1 and had to uninstall/reinstall NVM for the OS to see that the drives have moved.


- Everytime I tried to move the cables to other RAID enabled SATA ports, the NVMS BIOS saw the switch, but the OS never saw the switch.  


- I gather the OS didn't see the switch because the NVMS software didn't detect the change and  relay that info to the OS.

- Have not felt the need to go from an internal SATA optical drive to a USB/SATA adapter to use SATA optical drive as iRdMoose did to solve his RAID problems.


- At one time in DM, there were 3 NV nForce SATA Controller references.  

· Two references were on their own IRQ and I believe at the time they were HD1 on 1.0 and HD2 on 2.0 based on physical cabling on sata ports.

· Since all my RAID access errors have been secondary channel oriented, HD2 was placed on A/C 2.0 for testing.

· The 3rd reference was sharing an IRQ with the USB controller, and I'm thinking it was the SATA optical drive because of the sata gen 1 designation.

·  Since I've re-Ghosted my OS and put HD1 and HD2 on 1.0 & 1.1 respectively, I only see one NV nForce SATA Controller in DM.

· The optical SATA drive is on SATA port 5 and not showing up on a NV nForce SATA Controller as it did earlier.

· Not sure if that's good or bad.

- It absolutely does not matter what RAID A/C channels I use.  HD2, the hard drive designated as the mirror, always has an access error.  

- I've tried different sata ports and even different raid adapters with like channels, i.e 1.0 & 2.0.  It's always the drive designated as the mirror drive that has the problem

- Disabled NCQ via the NV S&R controller listing in DM for both primary and secondary channels.


- Disabled Tagged Queuing & Synchronous Transfers via disk drives> NV mirror listing  in DM.



- Still received raid access error on a/c 1.1 HD2.

RAID/SATA Oddities

- Recently saw something very interesting about the hard drives.  When I disengaged raid entirely and loaded the OS in a pure sata environment, the hd I consider HD2 on raid a/c port 2.1/sata port 4 was not acting properly in the OS. When I went to Device Mgr., I saw under SCSI & RAID controllers 3 SCSI & RAID controller listings.  Since I've got 6 sata ports, there are 3 SCSI & RAID controllers listed since each port pair have a primary and secondary channel per hard drive/cd-dvd drive.  

- Since sata ports 1 & 2 weren't being used, there were no device listings on the primary and secondary channels on one of the  SCSI & RAID controllers listed. The second SCSI & RAID controller listed HD1 on the primary channel/sata port 3 and HD2 on the secondary channel/sata port 4.  .Since sata port 6/raid a/c 3.1 was being used by the DVD-R/RW drive, it was listed under the secondary channel on the third SCSI & RAID controller listing, probably because I had port 5 set to RAID in the BIOS.  

- While searching Google to see if write caching was something I should even use with RAID; being that the S&R controller has write caching on/off abilities in addition to the hd's having write caching on/off abilities; I found that these S&R controllers have a built in hard drive speed test. 


- According to Storagereview.com, write caching is something that should be used with RAID.

- While in SATA mode, I did a speed test for HD1.  It showed a burst of 143 MB/s and a sustained 73 MB/s, exactly what I've seen in some reviews.  When I tried to do a speed test for HD2, it hung for awhile, finally completed, and gave results of burst 0 MB/s and sustained 0 MB/s.  Something was screwy.

- Through experimentation of uninstalling the HD2 directly in DM, rebooting, trying the speed test again, and disengaging HD2 (Safely Remove Hardware) along with uninstalling HD2 through DM, I was finally able to get speed test results on par with HD1. I got HD2 to the point where I felt it was able to perform the speed test consistently. Thought maybe all my raid problems might have been a driver not loading issue.

- Enabled all the raid settings again in the bios, set up HD1 on 2.0 as the boot drive, HD2 on 2.1 as the free drive that needed to be mirrored, and booted into a raid OS environment.  NV MediaShield (NVMS) said it saw the free hd and I was able to start a mirror build from HD1 to HD2.  An hour later, I checked the mirror build. NVMS was stuck on 40% and the system was frozen.  So, I turned off the system.

- The next morning, I found all these raid a/c 2.1 errors in Event Viewer-System.  The NVMS bios was saying both arrays (both? what?) were degraded.  Somehow, someway, NVMS stuck hds 1 & 2 in their own mirror arrays and considered both degraded.  I'm hating NVRAID very much at this point.

- Removed raid settings in NVMS bios and mobo bios to get everything out of raid mode.  Then I booted into the OS, checked to see if HD2 was still capable of getting speed test results. It was capable of speed testing properly after doing the disengage, uninstall, reboot method.  Then, I set up raid in the mobo and NVMS bios, cleared the data on HD2, set up my mirror again, entered the OS, and got the NVMS program to initiate a mirror build on HD2

- I thought about the fact that there's a raid controller and that the hd has its own built-in controller.  So, I thought maybe the reason why the raid controller was having issues with HD2 on a/c 2.1 was because HD2's controller was acting funny.  The thing that throws water on that idea to some degree is that when the hds cables were switched between raid ports, I got the same raid a/c 2.1 error on the other drive.  Although, at the time, I never tested the HD1 in a sata speed test, which you can't perform under a raid mirror, because I didn't know about this testing option until last night. So, I don't know if the raid errors on 2.1 for HD1 were the result of driver errors.

- As a test, I re-power cabled the hds to their own power line and not off the 3 power plug sata connector cable shared with the DVD drive.  Even though the power supply sata power connection has two sata cables branching off into two sets of 3 power plug connections for devices, I thought I'd experiment with giving the hds' the second cable that doesn't have the DVD drive off one of the 3 connectors.  The idea is that maybe there's some funky power business going on with the DVD drive during it's normal operations that causing problems with the hds.

- NVMS finished a mirror build from HD1 to HD2.  Although, what I wasn't happy about now was that I didn't check the S&R controller for the drives prior to mirroring.  While I had been explaining what I'd done to someone, I opened the S&R controller in DM for the hds and found that the secondary channel for HD2 on a/c 2.1 had the "Let BIOS select transfer mode" option deselected and hd2 has been downgraded to a sata 1 speed designation.

- The reason HD2 had been downgraded according to the pop-up message is because: The transfer mode for this device was set to a mode lower than what is  capable of because of excessive transfer errors to the device.  This will cause a loss of system performance.  Please check the cabling to the device and verify an 80 conductor flat ribbon cable is used for Ultra66 and higher transfer modes.

Asus & Nvidia Documentation Annoyances

Before I do anything, I read the user manuals and the PDF feature docs backwards and forwards. There is nothing in the Asus mobo manual that tells you about the rebuild function in the BIOS not working as a standalone function. There is nothing in the Nvidia MediaShield user manual that says that the BIOS rebuild option will allow you to reboot to the previously inaccessible OS in order to have the NVMS program rebuild the damaged array. Both manuals read as glorified feature lists, not as how-to manuals on using the features to any useful or meaningful degree.  There's just an implied fantasy that everything will always work and never go wrong.

Case in point, after the array was rebuilt for the umpteenth time, I checked the Event Viewer Application and System logs to see if there were any errors. On the previous rebuild attempt, .NET jacked up the rebuild session by needing to optimize itself. This time around, there weren't any errors, but suddenly, the system froze. So, I rebooted, saw the POST, saw the Nvidia MediaShield BIOS say it saw a healthy array, and waited for the Windows logo with progress bar to appear. It never arrived.

I looked at the hard drive LED light, saw a little activity, and vast amounts of nothing. Annoyed, but after counting to one minute, I hit the reset button. The same thing happened: POST, MS healthy array, no MS logo and progress bar. I thought, "I'll just grab the Ghost copy.". Well, the DOS Ghost program didn't get the proper info from the hard drives during it's query, and thus it didn't load the Ghost interactive environment. So, I rebooted again, tried DOS Ghost again and got the same nothing result.

Annoyed, I rebooted, hit F10 to go into the MediaShield RAID BIOS program, and deleted the array. Then, I set up the mirrored array again, hit F7, said "No don't delete the info on this array!", and now I had my mirrored array again. Because I was feeling irritated, I decided to not set the array as bootable and Ctrl-X'ed my way out of the NVMS BIOS. Lo and behold, the MS logo and progress bar showed up and I was booted back into the OS without any problems or bad Event Viewer Application and System alerts. 

Now, the only way I got back into the OS was by deleting and re-establishing the array in the NVMS RAID BIOS after it the mirrored array had been rebuilt. I don't know if all I had to do was set the array as non-bootable for things to work. Even so, I didn't read about what worked being a valid method for this scenario in the Help section or the PDF manual.  None of the documentation contains anything in the sense of "Ways of getting out of RAID jams".  I had no idea the method I used was going to work. I just said, "Well, let's try this for the heck of it..". Voila, it worked. Still, there's very little FYI, Best Known Methods, Stuff You Should Know to Save Yourself Time and Frustration info for the RAID newbie from Nvidia, and that's very disappointing.

----------

It turns out in order to get a 1:1 correspondence between sata ports 1-6 and RAID-1 A/C ports 1.0/1.1 thru 3.0/3.1, you need to have at least half the sata ports enabled for RAID in the mobo BIOS. During my tests, I found that having all sata ports enabled for RAID finally had the NV MS BIOS showing A/C associations of 1.0/1.1 for sata ports 1 & 2, 2.0/2.1 for sata ports 3 & 4, and 3.0/3.1 for sata ports 5 & 6. If I had less than half of the sata ports enabled for RAID in the mobo BIOS, then I'd start getting the oddball 1:0 correspondence between sata ports and RAID A/C associations. 

So, I enabled sata ports 1,3,5 for RAID, connected HD1 from the top of the case to sata port 1 and HD2 from the bottom of the case to sata port 2, and the NV MS BIOS saw the A/C connections as 1.0/1.1. Whether or not it's going to make a difference in terms of avoiding RAID errors from the controller and driver pov, the sata ports and RAID A/C now correspond on a 1:1 basis. The NVMS BIOS now showed 1.0/1.1 for sata ports 1 & 2, 2.0/2.1 for sata ports 3 & 4, and 3.0/3.1 for sata ports 5 & 6.

While I was waiting for my drives to rebuild for the umpteenth time, I walked through versions 5 & 6 of the NV MS user guides side by side. Not one of them had any info that mentioned what I discovered on how things work between the sata ports and NV MS BIOS RAID Adapter/Channel associations. Everything was just a glorified monkey-see-monkey-do feature description. 24 hours later, I haven't received a RAID error while doing something innocuous that doesn't put a strain on the system, like web browsing, which is what I was doing when I had the last RAID error.

----------

- Complete OS and system partition meltdown fubar due to shoddy, incomplete, and inconsistent NVRAID user guide documentation between nForce platform generations.


- Haven't lost any important docs or files because of backups.


- Have lost weeks of time and all of my patience with NVRAID.

- Only through trial and error, not detailed NVRAID documentation, do have a better idea of what I can and can't do with NVRAID.

· Thought I could rebuild the array from within the NV MS BIOS and away from the OS using the rebuild option on the menu.

· Makes sense since there are all sorts of apps that operate and do diagnostics outside of the OS proper.  Is my thinking too advanced?  Maybe so.

· Nothing ever happened.  No hds leaping to life and starting a rebuild.  No hd LED blinking rapidly or in a solid state to indicate work was being done.  Nada.

· Choosing the rebuild option for a drive in an array only serves as a flag to the OS that an array drive needs to be rebuilt.

· Array drives are only rebuilt from within the OS via Nvidia MediaShield if something isn't already jacked up with NMS.

· Once in awhile you got to uninstall NMS and reinstall if before it says, "Oh hey, you've got raid drives that need to be rebuilt".

· The drive that is flagged for rebuild will be rebuilt from the data on the drive that wasn't selected for rebuild.

· While getting your feet wet with the NMS BIOS , never ever initiate a rebuild on the data drive if you already initiated a rebuild on another drive.

· See "Fubar City".  Grab that Ghost image of the read-to-go OS and reinstall it on the data drive.  Sit back and enjoy yet another array rebuild.

· Nvidia has nForce 590SLI AMD drivers on its website that are dated around April 2006 (9.35).

· Asus has nForce 590SLI AMD drivers on its website that are dated around August 2006 (9.19).  

· The file versions listed in the readme file for the Asus nForce drivers are more current.

· Annoyingly, the nForce driver version mentioned in an Nvidia 169.21 video driver improvement notice (PDF) to fix a registry large memory access error is only in the Asus 9.19 drivers.

· My registry location for this error appears to have been fixed by the Asus drivers or by a WXPP update.
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